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1. Welcome 
Welcome to Turf, the EHR usability toolkit developed by SHARPC. Turf   is the first all-in-one, integrated software 

program designed specifically for safety-enhanced design validation. You can use a variety of features for 

usability testing of an EHR, including Summative User Testing, Formative User Testing, Heuristic Evaluation, 

Expert Evaluation, Descriptive Analysis, Inferential Statistics, etc. Our toolkit streamlines User Testing and 

Heuristic Evaluation and generates reports in the format required for Safety Enhanced Design certification.  

A unique feature of user testing in Turf   is Autoflow. With Autoflow, you can semi-automate the testing process 

by prompting the user through selected tasks. Autoflow is fully customizable to specific task actions, including 

displaying text files, playing short video clips, capturing images, recording media and filling in forms. Customized 

moderation of Turf   allows for a streamlined assessment of the user experience. In addition, Turf   captures 

keystroke events and task execution times. 

Turf   also allows for quick and easy documentation of critical usability problems during the Heuristic Evaluation 

module. Expert evaluators can record a video to demonstrate violations of heuristic principles or capture 

screenshots that further define the problematic areas. Evaluators can then identify violations and actionable 

design concerns by clearly marking up the screen with a violation box.  

Visit our website www.SHARPC.org for a free 30 day trial and experience the all-in-one integrated software 

system. 

2. System Requirements 
Please note that administrator privileges are required to install Turf 4.0.  

Operating System: Windows® 8.1, and 10 

Prerequisites: .NET framework version 4.5.3 or higher 

Processor: 1 gigahertz (GHz) or faster 

RAM: 4 GB or above 

Free disk space: 250 MB (for application install only) 

Screen Resolution: Up to 1920 x 1080 

User Access Control Privileges: Local system administrator or higher 

 

Note:  

a)  Turf 4.0 has been tested in Window® 8.1 and 10.  

b)  The storage requirements depend on usage. A typical recording with audio, video, and keystroke 

events will generate approximately 5-10MB data per minute. For seamless recording and playback, a 

dedicated video memory (GPU) is preferred. 

c)  To use OneDrive functions, an active Microsoft® Account with OneDrive® is required. 

System requirements to install Turf for Android in your smartphone or tablet 

Operating System: Android® 5.0 or higher 

Free disk space: 2 GB (to store the recorded video) 

http://www.sharpc.org/
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System  Privileges: Enable developer mode, USB debugging and install of 
third party apps. 

 

Note:  

a)  Turf for Android in Turf 4.0 has been tested in a Nexus® 9 device with Android® 5.0.  

b)  The storage requirements depend on usage. Recording of android device screen is initially saved in 

the device.  For this we recommend at least 2 GB of free space. To recover used space, the recordings 

can be manually deleted from the device once they are saved in Turf 4.0 

3. Step by Step Guide 
a)  Download the Turf software (available as a zip archive) from the Turf website 

b)  Go to the extracted folder and click the Turf 4.0 Setup.msi file 

c)  Click Next to proceed 

d)  Read the Research and Evaluation License Agreement and accept the terms to proceed by marking 

the checkbox and clicking the Next button 

e)  Click Next to continue to install Turf 

f)  Choose if you want to install Turf for all users or just for you. Click the Install button to begin 

installation 

g)  Installation will begin and the process is indicated in the progress bar 

h)  When the installation is completed, click Finish to close the setup window 

4. Turf   Interface 
4.1 Panels 

4.1.1 Projects Panel 

The Projects panel displays the list of all documents and folders, each user is working on separated by a 

Heuristic Evaluation project or a User Testing project. The Add New Product button allows the user to enter the 

name and version of the product, software, website or application they will be testing. Once the product has 

been created, it will show up in the Projects panel and new folders can be created that will organize the many 

documents and sessions. The folders are arranged in a tree fashion to allow for easy navigation and location of 

the correct folder. 

4.1.2 Details Panel 

The Details panel shows each individual files that are in the folders in the Projects panel. The documents can 

range from audio files, video files, imported PDFs, exported XML documents, screenshots, etc. 
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4.1.3 Heuristic Evaluation Problem Panel 

The Classify Problems panel contains three features that streamline the heuristic evaluation process. The New 

Problem button allows a user to create a new problem and link it to multiple user-defined marks. The Audit 

Problems button allows a user to agree, archive, or discard saved problems in a chosen location. The Rate 

Problems button allows a user to rate approved or agreed upon problems. 

4.1.4 User Testing Forms Panel 

The User Testing panel contains four forms often used in user testing. The Demographics form has many fields 

for collecting background information about a user including experience and education. The Usability Survey 

form is a usability survey with numerous radio buttons that resembles the commonly used system usability scale 

(SUS). The Moderator Notes form provides a large space for a user testing moderator to record his observations 

and other notes. The Performance Evaluation form contains numerous metrics for gauging user performance 

during a task, including task time, task success, and path deviation.  

4.2 Tab Functions in Turf   

4.2.1 File Tab 

The File tab in the Turf   interface organizes and contains access to all files created during Turf   sessions and 

those that have been imported for evaluation. It contains 5 buttons located on the left side of the Turf   

interface to help locate and navigate documents. The Recent button shows files, folders and projects the user 

has worked on most recently. Clicking the About TURF button will load a webpage where you would be able to 

watch different Turf video tutorials and learn more about the Turf software. The Activate button activates the 

full version of the product for legal use by the end user or enterprise. The OneDrive button allows you to log in 

to OneDrive and be able to view the files that you have already shared on OneDrive. The Exit button will 

immediately exit the Turf   program.  

4.2.2 Home Tab 

The Home tab allows users to quickly create new Projects. Click on either the Heuristic Evaluation or User 

Testing button to begin creating each session.  

 

*TIP* Before you click on Heuristic Evaluation or User Testing button, make sure you have added a new product 

by clicking on the Add New Product button in the Projects sidebar and make sure your new Product is selected 

before clicking a new Project.  

4.2.3 Heuristic Evaluation Tab  

The Heuristic Evaluation tab gives users the control to both organize folders, capture media and classify 

problems based on heuristic principles. Folders can be organized by clicking on the New Folder, Edit Folder and 

Delete Folder buttons represented by the yellow folder icons. Media can be captured in five different ways via 

Audio, Video, Keystroke, Screen, and Android buttons, either individually or in groups as decided by the user by 

checking or unchecking checkboxes assigned to each media type. Settings buttons for each media type allow for 
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deeper customization and show icons that reflect each type of media. According to heuristic principles, a New 

Problem, Audit Problems and Rate Problems buttons allow users to evaluate problems found in documents and 

screenshots with ease. A Report button with a printing icon allows users to print the problem descriptions, 

captured images, with or without marks, and the severity ratings for each problem.  

4.2.4 User Testing Tab 

The User Testing tab, similar to the Heuristic Evaluation tab, allows the user to assign folders and capture 

media. The User Testing tab, however, also has icons specific to its unique function that include forms for a 

testing session and Autoflow. The Demographics button brings up a mini tab with a sample form which a 

creator can add to an Autoflow session prompting the user to enter personal information. The Usability Survey 

button brings up a mini tab with questions for the user after the testing session. Moderator Notes button shows 

a mini tab that has a blank textbox for the moderator of the user testing session to record his or her thoughts. 

The Performance Evaluation button shows a form that a moderator can use to evaluate the results of the user 

testing session.  

Autoflow, a customizable user testing process, is a format of testing that prompts the user through a testing 

procedure using a series of forms and media to record, evaluate and survey user performance. Clicking the Set 

Up Autoflow button brings up an Autoflow settings popup window where the moderator can create and edit 

the order and content of the testing session. Clicking Run will start the recording and the Autoflow session will 

begin.  

4.2.5 Analyze Tab 

The Analyze tab offers a plethora of features for analyzing heuristic evaluation and user testing data by 

statistical and more basic means. A user first selects the data using the Query Files button. The data is then 

displayed on a pivot table. Columns can be re-grouped or re-ordered by dragging and dropping columns as 

desired.  

4.2.6 View Tab 

The View tab allows the user to customize the window layout according to their preferences. The Show Product 

Tree checkbox will expand the list of products in the Projects panel to show all documents and files. The Show 

Detail Panel checkbox will display or hide the Details panel on the bottom of the Turf   interface. The Show 

Properties checkbox will show or hide the Property panel on the right side of the Turf   interface. Clicking the 

Reset Window Layout button will reformat all panels to revert to the default sizes and locations.  

4.2.7 Settings Tab 

The Settings tab allows the user to adjust the color theme of Turf and the high level content detail of the system 

configuration. Clicking on any of the different icons in the Theme box will change the color and font of all Turf 

windows and panels. Under the System Configuration Management panel on the left side, 8 different settings 

are available for modification and customization. The Use Cases setting allows users to create a New Use Case, 

create a New Folder to organize use cases, Modify old folders, Delete folders, and Upload different files to a use 

case. The Descriptive Template setting allows user to create a New template, Load another template from file, 
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Export a template from an XML document and Delete a template from the list. The Widget Definitions setting 

allows users to specify the type of the mark in heuristic evaluation by specifying Button, TextBox, Check Box, List 

Box or ComboBox for both Windows and Android systems. The Color Definitions setting allows users to specify 

Name, Color, and Description. The color can be set to active by checking the Active check box for both the 

Windows event color and the Mark property color from the dropdown menu list. The Hot Keys setting allows 

users to Modify Hotkey Value associated with the Home, Heuristic Evaluation, User Testing, Analyze, and View 

tabs by specifying the ActionName, Action, Hotkey, and status of the key using an Active checkbox. The Video 

settings allow users to specify the maximum number of video tabs that can be opened at the same time. 

OneDrive settings allow you to customize the way that you want Turf interact with your OneDrive account. The 

Install Turf for Android button allows you to install Turf on your android smartphone or tablet device. 

4.3 Icons 

4.3.1 File Tab Icons 

 

 
 

The File tab is the welcome tab when the user first opens up Turf. It stays highlighted blue at all times to 

represent the main tab for finding recent files, folders and projects.  

Recent - Shows all file types recently opened.  

About TURF   - Provide you with different Turf video tutorials 

 Activate - The Activate button shows activation information of the product for legal use by the end user or 

enterprise. 

OneDrive   - Shows the files/folders that you have uploaded to your OneDrive from your Turf application. 

Exit – Closes Turf with a popup window to confirm.  
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4.3.2 Home Tab Icons 

 
 

Heuristic Evaluation - Opens a popup to create a Heuristic Evaluation project under a user chosen product 

folder. 

User Testing - Opens a popup to create a User Testing project under a user defined product folder.  

4.3.3 Heuristic Evaluation Tab Icons 

  

The Heuristic Evaluation tab has buttons and checkboxes that assist the user to identify and analyze heuristic 

violations using heuristic principles. The tab is divided into 4 sections: Folder, Capture Media, Classify Problems 

and Report.  

4.3.3.1 Folder 

 

New Folder – Creates a new folder under the Heuristic Evaluation project name 

Edit Folder – Renames the folder  

Delete Folder – Deletes a folder in the project 
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4.3.3.2 Capture Media 

 

Audio Settings – When checked, audio will be recorded through the microphone selected in the Audio Settings 

button.  

Video Settings – When checked, video will be recorded using the webcam selected in the Video Settings button. 

Keystroke Settings – When checked, capture events and capture controls are captured using the Keystroke 

Settings button.  

Screen Settings – When checked, a screenshot or video of the display chosen in the Screen Settings is captured.  

Android Settings – When checked, screenshots and events on the chosen android device will be recorded.  

Capture Image (F5) – Captures the image on the monitor screen based on the parameters selected in the Screen 

Settings. The hotkey F5 can be also be used to capture an image. 

Record (F7) – Records video of the screen as specified by the Screen Setting button. The hotkey F7 can also be 

used to start recording.  

Pause/Restart Record (F8) – Pauses and restarts the recording. The hotkey F8 can be used to pause a recording 

and then restart the recording.  

Stop Record (F9) – Stops and ends the recording. The hotkey F9 can be used to stop recording. 

4.3.3.3 Classify Problems 

 

New Problem – The New Problem button allows a user to create a new problem and assign it to multiple 

images. 

Audit Problems – Opens a popup where the user can choose which problem marks to audit and evaluate. 

Rate Problems – Opens a popup where the user can choose which problem marks to rate using heuristic 

principles. 
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4.3.3.4 Report 

 

Report – Opens a popup where the user can select the problem descriptions, captured images, with or without 

marks, and the severity ratings for each problem to print out a report. 

4.3.4 User Testing Tab Icons 

 

The User Testing tab has buttons and checkboxes that assist the moderator in customizing and conducting user 

testing. The tab is divided into 4 sections: Folder, Capture Media, Forms and Autoflow. 

4.3.4.1 Folder 

 

New Folder – Creates a new folder under the User Testing project name 

Edit Folder – Renames the folder  

Delete Folder – Deletes a folder in the project 

4.3.4.2 Capture Media 

 

Audio Settings – When checked, the audio will be recorded through microphone selected in the Audio Settings 

button.  
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Video Settings – When checked, video will be recorded using the webcam selected in the Video Settings button. 

Keystroke Settings – When checked, capture events and capture controls are captured using the Keystroke 

Settings button. 

Screen Settings – When checked, a screenshot or video of the display can be chosen in the Screen Settings is 

captured.  

Capture Image (F5) – Captures the image on the monitor screen based on the parameters selected in the Screen 

Settings. The hotkey F5 can also be used to capture an image. 

Record (F7) – Records video of the screen based on the parameters specified in the Screen Setting. The hotkey 

F7 can also be used to start recording.  

Pause/Restart Record (F8) – Pauses and restarts the recording. The hotkey F8 can be used to pause a recording 

and then restart the recording.  

Stop Record (F9) – Stops and ends the recording. The hotkey F9 can be used to stop recording. 

4.3.4.3 Forms 

 

Demographics – Opens a tab with a form containing boxes for a user to enter their demographics (e.g., Full 

Name, Gender, Age, etc.)  

Usability Survey – Opens a tab with a survey containing radio buttons for a moderator to give to a user at the 

conclusion of a user testing session. 

Moderator Notes – Opens a tab with a form containing a box where a moderator can add notes from the user 

testing session. 

Performance Evaluation – Opens a tab with a form containing boxes and radio buttons for the moderator to 

enter values at the conclusion of the user testing session.  

4.3.4.4 Autoflow 

 

Set Up Autoflow – Opens a popup that allows creation and customization of an Autoflow session by choosing 

various contents specified in the designated dropdown list. 

Run – Starts the Autoflow session.  
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4.3.5 Analyze Tab Icons 

 
 

The Analyze tab has buttons and checkboxes that perform detailed analytical functions on the heuristic 

evaluations and user testing data. The tab is divided into 7 sections: Data, Process Raw Data, Descriptive 

Analysis, Compare Means, Calculate, Regression, and Correlation. 

The Analyze tab allows the user to query the data they collected and to analyze the data using statistical 

methods. The Query Files button brings up a pop-up dialog box with a tree view of all the products, projects, 

folders and files. Users can select files by the file type and the data will be displayed on the sheet. The Load Files 

button allows user to open the files with the following extension “.csv, .rtf, .xls, and xlsx”  into the Turf and 

perform analytical functions on them. Click on the New Sheet button will create an empty sheet, users can enter 

their data manually or copy and paste data into this new sheet from other files, such as excel sheet. The Convert 

to Numeric Variable button will convert the selected data to the numeric type. Users can do simple descriptive 

analysis by checking the checkbox in front of the descriptive statistics and clicking the Run button. The Two-

Sample T button brings up a pop-up dialog box which allows users to choose the grouping variable and test 

variable(s) from the variable(s) list and to run the Two-Sample T test by clicking the OK button. The Mann-

Whitney U button brings up a pop-up dialog box which allows users to choose the grouping variable and test 

variable(s) from the variable(s) list and to run the Mann-Whitney U test by clicking the OK button. The One-way 

ANOVA button brings up a pop-up dialog box which allows users to choose factor and dependent variable(s) 

from the variable(s) list and to run the one-way ANOVA test by clicking the OK button. The Count button allows 

users to count the frequency of the selected item in the data. The SUS Score button allows users to calculate the 

SUS score from the original SUS survey data. The Linear Regression button brings up a pop-up dialog box which 

allows users to choose the factor and dependent variable(s) from the variable(s) list and run the linear 

regression by clicking the OK button. The Pearson Correlation coefficient button brings up a pop-up dialog box 

which allows users to choose the dependent variable(s) from the variable(s) list and run the Pearson Correlation 

coefficient by clicking the OK button. 

4.3.5.1 Data 

 

Query Files – Opens a pop-up dialog box with a tree view of all the products, projects, folders and files. User can 

select files by the file type and the data will be displayed in the sheet. 

Load Files – Allows users to open the files with the following extension “.csv, .rtf, .xls, and xlsx” into the Turf and 

perform analytical functions on them 



Turf Reference Manual    

 
  

17 

New Sheet – Creates an empty sheet, where users can enter their data manually or copy and paste data into this 

new sheet from other files, such as excel sheet.  

4.3.5.2 Process Raw Data 

 

Convert to Numeric Variable - Convert the type of the data to numeric 

4.3.5.3 Descriptive Analysis 

 

Sum – Adds all data values 

Minimum – Finds the lowest data value 

Maximum – Finds the highest data value 

Mean – Finds the average of the data values 

Variance – Measures how far a set of numbers is spread out. 

Standard deviation – Shows how much variation or dispersion from the average exists. 

Range – Shows the difference between the largest and smallest values. 

Kurtosis – Measures the “peakedness” of the probability distribution of a real-valued random variable. 

Skewness – Measures the asymmetry of the probability distribution of a real-valued random variable about its 

mean.   

Run – Analyzes the mathematical functions checked. Users can do simple descriptive analysis by checking the 

checkbox in front of the descriptive statistics and clicking the Run button. 

4.3.5.4 Compare Means 
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Two-Sample T – Determines if the mean of two sets of data are significantly different from each other. The null 

hypothesis is that the means of the two populations are equal.   

Mann-Whitney U – A non-parametric test of the null hypothesis that two populations are the same. 

One-Way ANOVA – Compares means of three or more samples, test the null hypothesis that samples in two or 

more groups are drawn from populations with the same mean values. 

4.3.5.5 Calculate 

 

Count – Counts the frequency of the certain values in data. 

SUS Score – Converts the responses of the 10 item questions to a SUS score. 

4.3.5.6 Regression 

 

Linear Regression – Models the relationship between a scalar dependent variable y and one or more 

explanatory variables denoted X. The case of one explanatory variable is called simple linear regression.  

4.3.5.7 Correlation 

  

Pearson Correlation coefficient –  It is a measure of the strength of the association between the two variables, 

giving a value between and including +1 and -1, where 1 is total positive correlation, 0 is no correlation, and -1 is 

a total negative correlation. 
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4.3.5.8 Analysis Report Board 

 

Users can export their data and analysis results to the Analysis Report Board (storyboard). There you can view, 

search, load an external .XML file, save, print, export, Email and add watermark to the content in the analysis 

report board. 

4.3.6 View Tab Icons 

 

 

The View tab has a button and checkboxes to help the user configure the side panels. There is only one section, 

the Show section that provides control over the Turf interface.  

4.3.6.1 Show 

Show Product Tree – Shows or hides the Projects panel on the left side of the interface. 

Show Detail Panel – Shows or hides the Detail panel on the bottom of the interface. 

Show Properties – Shows or hides the Property panel on the right side of the interface. 

Reset Window Layout – This button resets the panels to the original viewing setting.  

4.3.7 Settings Tab Icons 
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The Settings tab has buttons and a panel to customize the Turf experience. It has one Theme section and one 

side panel, System Configuration Management.  

4.3.7.1 Theme Icons 

The Theme icon buttons change the color and font of the Turf interface during the duration of the Turf session. 

The user can choose from 14 unique themes to overlay the Turf interface.  

4.3.7.2 System Configuration Management 

Use Cases – Opens a tab for users to create and modify use cases.  

Descriptive Template – Opens a tab that allows users to alter and customize the User Testing forms. 

Widget Definitions – Opens a tab that allows users to specify the type of mark chosen during Heuristic 

Evaluation for both Windows and Android systems 

Color Definitions – Opens a tab that allows users to customize the color for window event color and mark 

property color for Heuristic Evaluation and User Testing. 

Hot keys – Opens a tab that allows users to choose and activate hotkeys for each of the 6 Turf tabs.  

Video Settings– Opens a tab that allows users to specify the maximum number of video tabs that can be opened 

at the same time. 

OneDrive Settings – Opens a tab that allows users to customize OneDrive related functions 

Install Turf for Android – Opens a tab that allows users to install Turf Android app on their desired android 

device 

 

4.3.8 Details Panel Icons 

 

The Details bar is located on the bottom of the Turf   interface and organizes the varying files contained in each 

project folder. It can be temporarily hidden by clicking the black push pin in the top right of the bar. To promote 

organizations it orders the details of the files by Name, Type, Create Data Time, Creator and Size.  

Import Files – Opens a popup window where users can select any file type to upload to Turf.  

Export Files – Opens a popup window where the user selects which folder to export the document(s). 

Delete – Deletes the selected file.  
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Dropdown box – Allows the user to choose the file view in the tab in either tree, detail or thumbprint format.  

Image Files – Blue and green landscape icon represents the image files 

Video – Black and white icon with a headphone and movie reel represents video files 

5. Media Capture Procedures 
5.1 Adjusting Settings 

Turf   allows for customization of recording media settings, allowing the user to choose what type of media to 

capture and specify the settings to their individual case and need. 

5.1.1 How to Adjust Audio Settings 

The Audio Settings checkbox and icon allows the user to decide whether or not to record audio from the user 

testing session. When clicked, the microphone icon opens a popup where the user can click on a dropdown 

menu to choose which Microphone, if any, they would prefer to use for the recording. If many microphones are 

attached to the computer, this dropdown will have all those that are recognized and ready for record. If not, the 

default computer microphone, (if available) will be used.  

5.1.2 How to Adjust Video Settings  

The Video Settings checkbox and icon provides the user with the option to opt out of using the webcam. Clicking 

on the filmstrip icon for video settings opens a popup where users can choose their own options for Webcam 

Device. If many webcams are connected to the computer, the user can choose their webcam from the 

dropdown menu.  Also, the user can assign different qualities to video files by checking on the any of radio 

buttons listed in the “Quality” section. 

5.1.3 How to Adjust Keystroke Settings 

The Keystroke Settings checkbox and icon allows the user to decide whether to Capture Event(s) and/or 

Capture Controls. Keyboard Events captures keystrokes on the keyboard. Mouse Events capture mouse clicks 

and scrolls. Users can choose to use MSAA (Microsoft Active Accessibility) or UI automation (user interface 

automation) in full or compact mode. To complete capturing keystroke controls, users can either Capture 

Widget Container Structure or Capture the image of the control under each event.  

5.1.4 How to Adjust Screen Settings 

To adjust Screen Settings, choose which Monitor, Region and Quality of the screen you wish to capture. Clicking 

on Identify Monitors briefly shows a large number on the screen of the Turf assigned monitor number if more 

than 1 monitor is connected. Clicking on Customize Region minimizes Turf   and allows the user to highlight their 

specified region to record or capture by dragging the red dashed line to encircle the desired area of the screen. 

The Minimize Turf   checkbox will minimize and open Turf   when the Capture Image (F5) is clicked or keep Turf   

minimized when the Record (F7) button is clicked. The Delay (sec) checkbox issues a countdown on the screen 

until Turf   either captures a screenshot or begins recording. The Display immediately after Capture checkbox 
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immediately brings up the image or video just captured in the large tab screen and also in the Details tab. The 

Show mouse hot spot check box shows the spot of the mouse on the screen. The radius and color of the spot 

can be set in the corresponding boxes. You can modify the quality (and file size) of image(s) or video(s) captured 

in Turf   by checking on the corresponding radio buttons specified in the Quality section. 

5.1.5 How to Adjust Android Settings 

The Android Settings checkbox and icon allows the user to capture the screen and events of an android device 

running Turf application.  

5.1.6 How to Capture an Image 

To capture an image, the Screen Settings must be configured. The Screen Settings icon opens a popup window 

where the user selects the monitor screen to capture, the region of the screen to capture and the quality of the 

image(s) to be captured. Click OK to save changes and close the popup and click Capture Image (F5) to take a 

screenshot.  

5.1.7 How to Record Video 

To record a video, first configure settings by clicking on the Video Settings button, specifying the webcam, and 

choosing the desired video quality. 

6. Heuristic Evaluation Procedures 
6.1 Launch and Set Up a New Heuristic Evaluation Project 

6.1.1 Launch Turf 

After loading the software on the computer, a user will launch Turf by double clicking on the Turf desktop icon. 

Then the user will see the File interface where she can create a new product for the heuristic evaluation. 

6.1.2 Create a New Product 

a) Create a new product evaluation folder 
i) Go to Home tab 
ii) Click the Add New Product 
iii) Enter the product name (e.g., Alpha)  
iv) Enter the product version (e.g., Alpha)  
v) Enter the vendor name (e.g., SharpC) 

vi) Click the Save button 
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6.1.3 Set up a New Heuristic Evaluation Project Folder 

After you set up a new product, choose the type of usability method (e.g., Heuristic Evaluation or User Testing) 

to conduct. In this case, choose Heuristic Evaluation. 

a) Create a heuristic evaluation project 
i. Select your product 

ii. Click on the Heuristic Evaluation icon 
iii. Fill in Heuristic Evaluation project information in the pop-out window  
iv. Select a usecase (s) 
v. Click the Next button 

vi. Select predefined heuristic evaluation template (e.g., select Expert Review)  
vii. Click the Finish button 

 

a)-i Go to Home tab 

a)-ii Click the Add New 
Product 
 

a)-iii Enter the product 
name 
 

a)-iv Enter the product 
version 
 

a)-v Enter the vendor 
name 

a)-vi Click the Save 
button 
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a)-i Select your product 

a)-ii  Click on the on the  heuristic Evaluation icon 

a)-iii Fill in Heuristic Evaluation project information in 

a)-iv Select a usecase(s) 

a)-v Click the Next  button 
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6.2 Capture a Screen Shot and Physically Mark Problems 

6.2.1 Capture a Screen Shot 

Screenshots can be captured to inspect interface design violations. First, you need to create a folder. You can 

create a folder to hold all of the evaluation projects on a product. For example, you may want to test multiple 

tasks (e.g., e-prescribing, creating a patient record and medication reconciliation) for a single EHR (electronic 

health record) product. 

 

 

 

 

a)-vi  Select predefined heuristic evaluation template 

a)-vii  Click the Finish button 
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a)  Create a new folder 
i. Select the HE project 

ii. Click on New Folder in the Heuristic Evaluation tab 
iii. Rename the folder to reflect the project and product (e.g., HE SharpC EHR)  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

a)-i  Select HE project 

a)-ii  Click on the New Folder in HE tab 

a)-iii  Rename folder to reflect the project and product  
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b)  Configure Screen Settings 
i. Click Settings under the Screen checkbox 

ii. Click Identify Monitors button, then select the monitor that displays the image to be evaluated 
iii. Select a region (e.g., click Full Screen button) 
iv. Click OK button 

 

 
 
 
 
 
 
 
 

b)-i Click Settings under the Screen checkbox 
 

b)-ii Click Identify Monitors button, then 
select the monitor that displays the image to 
be evaluated 
 

b)-iii Select a region (e.g., click Full Screen 
button) 
 

b)-iv  Click OK button 
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c)  Capture Image 
 

i. Click the Capture Image  (or press F5 on the keyboard), (e.g., Click the Capture Image (F5) button 
to capture the Medication Search screen) 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c)-i  Click Capture Image 
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6.2.2 Physically Mark Problems 

After you inspect the user interface, drag the mouse over the problematic widget to mark it on the screenshot. 

a) Mark a Problematic Widget 
i. To mark the problem, drag the mouse over the widget (e.g., mark the medication search 

textbox) 
ii. Click Save to save the mark  

 

 
 

 

6.3 How to classify problems 

 

6.3.1 New Problem 

This button creates a new problem file form and allows a user to assign design violation to user-defined marks. 

After selecting the marks, the location can be further specified in the Problem Location field. The Problem 

Description field provides a space for describing the heuristic violation in detail. The Design Violation field 

contains options to specify the heuristic being violated. There are two methods to perform this task: 

a)  Method 1 
i. With your mouse on the marked problem, right click on the mark, and then left click to select 

the “Add a problem about this mark” option. 

ii. A problem description form is open. Fill in the required information 

iii. Click the Save button at the bottom right of the screen 

a)-i drag the mouse over the widget 
 

a)-ii  Click Save button 
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a)-i Add a problem about this mark 
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b)  Method 2 
i.  Left click the New problem button from the menu panel, this will open a new screen 

ii. Left click on  “Select user defined marks on image (s)” at the top of the screen 

This opens a pop up window that shows all marks on the system. You must limit the scope for the 

problem description by identifying which marks or widgets this description should be attributed to.  

iii. Select the mark(s) you would like to add description to 

iv. Click on the OK button 

Once clicked, a single problem description form is opened. The items displayed on this form are 

determined by what is built into your template. In our form, we included problem location, problem 

description, and design violation. 

v. Fill in the required information 

vi. Click the Save button at the bottom right of the screen 

 

a)-ii  Fill in the required information 
 

a)-iii  Click the Save button 
information 
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b)-ii  Left  click on “Select user defined marks on image (s)”  
 

b)-i  left click the New problem button 
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b)-iii Select the mark(s) you would like to add description to 

b)-iv Click on the OK button 



Turf Reference Manual    

 
  

34 

 

 

Note: The design violation list can be modified by the system administrator. See Section 9 of this manual. After 

entering all the information, please save using the Save button at the bottom.  

6.3.2 Audit Problem 

This button displays an Audit Problem tab that allows users to approve, discard, or archive problems. A user 

must first choose problems to evaluate by selecting a location in the Project Tree. The problems list display can 

be filtered using the checkboxes at the top. Unclassified problems will have a yellow-orange color that will 

change colors upon classification. There are three options for classification: archive, agree, and discard. Selecting 

the archive radio button will save the problem for later consideration and the color will change to purple after 

saving. Choosing the agree radio button will allow the problem to be rated and change the color to green after 

saving. Clicking the discard radio button will prevent the problem from being rated and displayed on the report. 

The color will change to gray after saving. Please be sure to save once you’ve chosen an option.        

a)  Audit Problem 
i. Select the correct user folder 

b)-v Fill in the required information 
 

b)-vi Click the Save  button 
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ii. Click on Audit Problem button 

iii. Select the identified problems you want to perform the Audit function on  

iv. Click OK button 

v. Classify each problem as either being agreed to, discarded, or archived  

vi. Click on the Save button 

 

 

 

a)-ii Click on the Audit button 
 

a)-iii Select the identified problems 
 

a)-iv Click OK button 
 

a)-i select the correct user folder 
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6.3.3 Rate Problem 

This button provides a place to rate the problems that have been agreed upon. A user must first choose a 

location with agreed upon problems in the Project Tree. A display similar to the one found in the Audit Problem 

section will appear with the reference image on the left and list of approved problems on the right. Rating 

options include 1 (minor), 2 (moderate), 3 (major), and 4 (catastrophic). Review the agreed upon problem and 

choose the most appropriate rating. Please be sure to save once you’ve chosen an option. 

a)  Rate Problem 
i. Select the correct user folder 

ii. Click on Rate Problem button 

iii. Select the identified problems you want to perform the Rate function on  

iv. Click OK button 

v. Classify each problem as either being agreed to, discarded, or archived  

a)-vi Click Save button 
 

a)-v Classify each problem as either being agreed to, discarded, or 
archived  
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vi. Click on the Save button 

 

 

a)-ii Click on the Rate button 

a)-iii Select the identified problems 

a)-iv Click OK button 

a)-i Select the correct user folder 
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6.4 How to print a report  
This button allows a user to print a report of the captured problem descriptions, images, and the severity ratings 

of each problem. Clicking on the Report button will open up a window where the user can choose different 

options based on his preferences. For example, if you are only interested in generating a report that shows 

images with identified marks, you will need to check the ckeckbox for the“Print Image”, and select “Images with 

Marks” radio button. Additionally, you will need to uncheck/de-select the other checkboxes and radio buttons. 

So, based on your preferences, click on the appropriate check boxes and press the Print button at the bottom of 

the window for your paper report.  

a)  Generate Heuristic Evaluation Report 
i. Go to heuristic Evaluation tab 

ii. Click the Report button 

iii. Check/uncheck the checkboxes and radio buttons based on your preferences  

iv. Click the print button at the bottom of the page 

v. Print the report or export it in your preferred format by clicking on the correspond buttons  

a)-v Review the agreed upon problem and choose the most appropriate rating  
 

a)-vi Click Save button 
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a)-i Go to heuristic Evaluation tab 

a)-ii Click the Report button 

a)-iii Check/uncheck the checkboxes and radio buttons based on 

your preferences  

a)-iv Click the Print button 

a)-v Print the report or export it in your preferred format by clicking 

on the correspond buttons  
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7. Installing Turf for Android-Capture 

events using Turf Android  

 
7.1 Installing Turf for Android 

 
The Install Turf for Android button allows you to install Turf on your android smartphone or tablet device. Once 

you have Turf installed on your device, you can start capturing the screen and events of your android device. To 

learn more about using Turf in an android device, please click here.  

7.1.1 How to setup your device 

The number of steps or the suggested configuration may vary depending on the devices. The following are 

suggested steps for any devices with Android 5 or greater. Here, we will present the instructions for Nexus 9 

tablet. 

Step 1: Check your android version 

Setting >> System >> About tablet >> Android Version 

The version of your Android device OS must be at least 5.0. If the OS version is less than 5, please upgrade it to 

Android 5.0 or later. 

Step 2: Enable Developers mode 

i. Go to Settings 
ii. Slide down to the “System” panel 

iii. Click on “About tablet”` 
iv. Press the “Build Number” item seven times 
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a)-i  Go to settings  

a)-ii  Slide down to the 
“System” panel  

a)-iii Click on  “About 
tablet”  
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Step 3: Configure Developer settings  

i. Go to Settings 
ii. Slide down to the “System” panel 

iii. Click on “Developer options” 
iv. Check the checkbox to select “USB debugging” 

a)-iv Press the “Build 
Number” item 7 times 
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b)-i Go to settings  

b)-ii Slide down to  the 
system panel  

b)-iii Click on the 
“Developer Options”  



Turf Reference Manual    

 
  

44 

 
 

Step 4: Enable side loading apps 

Open Settings >> Personal >> Security >> Device Administration 

a) Set Unknown Sources to ON 

 

7.1.2 Device Driver Setup 

Connect your device to the computer using USB. If you are connecting the device for the first time, windows 

should automatically detect and install it and you will see a “Installing device….” window. This will appear only 

the first time you connect your device to your computer. 

b)-iv Slide down to the 
system panel  
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After successfully installing the device, you will see a notification, such as the one below. 

 

Go to “My Places / This PC / My Computer", and check if you can see your device name.  

 

Windows automatically install s 
your device once you connect 
it  to the computer 
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If Windows does not recognize your device, you won’t see your device name. Contact your device vendor to 

obtain appropriate drivers.  

Now,  you can launch Turf and start installing the Turf for Android. For instructions, please click here. 

 

Note: If Turf does not detect your device, you need to check if you have 

1) Activated USB debugging and permitted the installation of 3rd party applications on your device.  

2) Installed the appropriate device drivers for ADB interface. Please follow the following steps to install 

drivers for ADB interface (Only for Google Nexus Devices. For others, refer to vendor sites) : 

i. Go to“Device Manager” 
ii. Click on the small arrow next to “Android Device” to expand it.  

iii. If  “Android Composite ADB interface” is present, drivers are correctly installed.  
a. If you do not see this, your device may appear as “Other device”. Click on the small arrow next 

to the “Other devices” to expand it. 
iv. Right click on the “ADB interface”, and select “Update Driver Software”. Before doing this, make 

sure you have already downloaded the appropriate driver software. For instructions on how to 
download driver for Google Nexus devices, please click here. 

v. Browse for Driver software on your computer and wait for the device to be installed and 
enabled 

vi. After installation unplug the device 
 

 
 

 

i- Click on “Device 
Manager” 

iii- Click on the small 
arrow next to the “Other 
devices” to expand it 
 

iv-  Right click on the 
“ADB interface”, and 
select “Update Driver 
Software” 
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7.1.3 Install USB driver in Windows 

Step1: Download 
 

i. Go to the following link to download the Google USB Driver on your desktop computer 
http://developer.android.com/sdk/win-usb.html.  

 
 
Step2: Instructions for installing the driver  
 

i. Unzip the downloaded folder by extracting its components 
ii. Connect your Android device to your computer using a USB 

iii. Right click on the Computer icon and click on the “Manage” item 
iv. Click on “Device Manager” from the left panel 
v. Click on the small arrow next to the “Other devices” to expand it 

vi. Right click on the “ADB interface”, and select “Update Driver Software” 
vii. Browse for Driver software on your computer and wait for the device to be installed and 

enabled 
viii. After installation unplug the device 

 

C) Step1-i Download 
Google USB Driver  

v- Browse for Driver 
Software on your 
computer  

http://developer.android.com/sdk/win-usb.html
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7.1.4 Configuration and Installation 

Follow the following steps to utilize the Turf android app. The number of steps or the suggested configuration 

may vary depending on the devices. The following are suggested steps for any devices with Android 4.4 or 

greater. 

a. Turf Installation on Android Devices 
 

Step1: Install Android in Turf 
 

i. Connect the device to your computer  
ii. Open Turf 

iii. Go to Settings 
iv. Select “Install android” 
v. Click on the “Install” button 

 
 
 
 

Step2: Activating Turf Keyboard and Turf Launcher 
 

i. Open the Android device 
ii. Go to Settings 

iii. Go to “Personal” panel 
iv. Click on “Language and input” 
v. On the “Language & input” screen, click on “Current keyboard” 

vi. Click on “CHOOSE KEYBOARDS” 
vii. Turn on the “turf Keyboard” item 

viii. Click on the OK button on the “Attention” window 
ix. Get back to the “language & input” window and click on “Current Keyboard” 
x. Click on the “turf Keyboard” radio button to select it 

xi. Go back to Settings 
xii. Go to the “Device” panel 

xiii. Click on the “Home” item 
xiv. Click on “Turf launcher” radio button to select it 
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d) step2-ii Go to settings  

d) step2-iii Go to 
“Personal’ panel  

d) step2-iv Click on 
“Language & input”  
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d) step2-vi  Click on 
“CHOOSE KEYBOARDS”  
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d) step2-vii  Turn on “Turf 
Keyboard” item  
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d) step2-viii  Click on OK 
button 
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d) step2-ix  Click on 
“Current Keyboard”  
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d) step2-x  Click on turf 
Keyboard radio button  
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d) step2-xii  Go to 
“Device” panel  

d) step2-xi  Go to Settings 

d) step2-xiii  Click on the 
“Home” item 
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After successfully installing Turf on your Android device, you will be able to use Turf Android features. 

Note: After you finish working with Turf, make sure to turn off the Turf keyboard and launcher in your android 

device. This is to ensure that your device activities are not being logged. 

7.2 Capture events using Turf Android 

 
a) Follow the following steps to use Turf Android features  

i. Go to User Testing tab, select the folder where you want to store your data  

ii. Check the checkbox for Android in the Capture Media ribbon, under the User Testing tab at the top of 
the screen, to select it 

iii. Click on Android Settings to select the parameters that you would like to capture  

d) step2-iv  Click on the 
“turf Launcher”  radio 
button to select it 
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iv. Press  Record (F7) button to record data 
v. Once you are done with recording, click Stop Record (F9) button to stop the recording. 

 

 

 

 

 

 

 

 

 

 

 

 

a)-ii Check the chechbox 
in front of the Android 
item to select it 

a)-i Go to User Testing 
tab 

a)-iii Click on the Settings 
to select the parameters 
that you want to capture 

a)-iv Press Record button 
(F7) to record data a)-v  Click Stop Record 

button to stop recording 
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8. Using Turf Android App- Example  

 
8.1 Using Turf Android app: Conduct a User Testing Project 

and analyze it 

 
a) Perform a User testing project 

 
i. Open Turf on your computer 

ii. Create a User Testing Project in Turf- For instructions on how to create a user Testing file, click on the 
following link (https://sbmi.uth.edu/nccd/turf/training-media/) 

iii. On the “User Testing” tab, check the checkbox in front of the “Android” item  
iv. Click on the Settings to adjust the desired settings 

a. Checking the keyboard events checkbox will allow for recording keyboard activity (only if you 
have already set Turf Keyboard as the active input on your android device, please refer to 
settings on how to setup Turf for Android) 

b. Checking the Record screen checkbox will allow for recording all screen activity. The recordings 
are initially saved in the device and then moved to the computer. 

v. Click on the Record button or press F7 
vi. Example task in your android device: Launch the Chrome application on your android device 

a. Click in the address bar and type http://drogith.com/dehr 
b. In the search bar, enter Metformin 
c. Pick Metformin 500mg Oral tablet 
d. Click on the “Add to Order” button 
e. On the pop up window (Edit Medications Details), click  the “Add” button to add a problem 
f.  Select “E11.9 Non-insulin dependent Capture” from the dropdown list 
g.  Click  the “Add” button 
h. Enter a dose for medication, e.g., 500 mg 
i. Enter 30days for the “duration” 
j. Select oral as the rout from the drop down menu 
k. Enter 30 in the “Dispense” field  
l. Enter 1 for the “Take” field 
m. Select “BID” for the “Frequency” field 
n. Choose “Start” and “End” Date 
o. Enter “Take after meals” for the “Pt instruction field” 
p. Click on the “Save and Close” button  
q. Click on the “Sign Order” button 
r. Click on the “Confirm” button 

vii. Now, return to Turf in your computer 
viii. Click on “Stop Record” button (F9) to stop recording 

ix. Turf will upload the saved files from your android device to computer. This might take a while, do not 
disconnect your device. 

Once completed, the recordings will be available in Turf for analysis 

https://sbmi.uth.edu/nccd/turf/training-media/
http://drogith.com/dehr
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b)  Using Turf android app: Analyze the recordings 
 

Double click on the recorded files on the “Details” panel to view their content (Make sure that you have 
selected the desired folder). Double click on the windows event file to view the recorded key events 
 

i. The first column records the time of each event 
ii. The second column records the name of apps that used during the recording. If it is empty, it 

shows that only the main system was used. 
iii. The third column describes the specifications of a touch activity. A touch action is defined by the 

finger id, width of touching finger, pressure, and the x, y location on the screen. As a result, a 
single touch might be presented with 2-8 rows in the event file. Subsequently, a single gesture - 
series of touch - can have as many as 20-40 rows in the event file.  

iv. The fourth column provides numerical values for x, y and other parameters 
v. The fifth column contains the text data for key presses. As the number of rows that a single 

touch can have is more than one, the key press data can also have more than one row. 
 
 

a)-iii Check the checkbox 
in front of the Android 
item 

a)-iv Click on the Settings 
to adjust your desired 
settings 

a)-viii Click on “Stop 
Record” button to stop 
recording 
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9. User Testing Procedures 
 

9.1 Launch and Set Up a New User Testing Project 
 

9.1.1 Launch Turf 

After loading the software on the computer, a user will launch Turf by double clicking on the Turf desktop icon. 

Then the user will see the File interface where she can create a new product for the heuristic evaluation. 

9.1.2 Create a New Product 

a) Create a new product evaluation folder 
i. Go to Home tab 

ii. Click the Add New Product 
iii. Enter the product name (e.g., Alpha)  
iv. Enter the product version (e.g., Alpha)  
v. Enter the vendor name (e.g., SharpC) 

vi. Click the Save button 
 

b)-i The time 
of each event 

 

b)-ii The 
apps’name 

 

b)-iii 
Specifications 
of a touch 
activity 
 

b)-iv 
Numerical 
values for 
parameters 
 

b)-v This 
column 
contains text 
data for key 
presses 
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9.1.3 Set up a New User Testing Project Folder 

After you set up a new product, choose the type of usability method (e.g., Heuristic Evaluation or User Testing) 

to conduct. In this case, choose User Testing. 

a) Create a User Testing project folder 
i. On the projects panel, click on the User Testing icon 

ii. Fill in User Testing project information in the pop-out window  
iii. Select the predefined use cases, e.g., check Electronic Prescribing and Clinical Information 

Reconciliation. You cannot add these to a project later, so choose all you think you will use now. 
We have included the NIST Use Case documents for the eight required functions for Meaningful 
Use Stage 2. Your administrator may add other reference materials for you. 

iv. Click the Next button 
 

a)-i Go to Home tab 

a)-ii Click the Add New 
Product 
 

a)-iii Enter the product 
name 
 

a)-iv Enter the product 
version 
 

a)-v Enter the vendor 
name 

a)-vi Click the Save 
button 
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9.1.4 Associate Data Forms with Your Project 

In this step you will associate the correct form with the button from which you will access it. You cannot add 

these to a project later, so it is best to choose any you think you will use now.   

a) Associate data forms with your project 
i. Using the drop down menu, select the data templates you want to use 

ii. The Advanced Settings button allows you to customize the naming conventions for your image, 
video and problem files. For now, we will use the default settings  

a)-i  Click the User 
Testing folder 
 

a)-ii Fill in User Testing project 
information  
 

a)-iv Click the Next 
button 
 

a)-iii Select the 
predefined use cases 
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iii. Click Finish button 
 

 
 

9.2 Autoflow 

 

Autoflow allows the moderator to automate user testing session in a step by step fashion. The moderator can 

predefine actions, including, “Display PDF File”, “Display RTF File”, “Display Video File”, “Capture image”, “Fill in 

Demographic”, “Fill in SUS”, “Fill in Moderator Notes”, and “Fill in Performance Notes”. When you run an 

Autoflow session, Turf will follow the default configuration, and process its actions automatically. 

a)-i Select the data templates you want to use  
 

a)-ii  The Advanced Settings button allows you to customize the 
naming conventions for your image, video and problem files  

a)-iii Click Finish 
button  
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9.2.1 Set Up Autoflow 

Before a user can start using Autoflow, a configuration must first be created and designated. 

a)  Autoflow Configuration- Part 1 
i. Go to User Testing tab  

ii. Double click on your desired product to open a list of the projects 

iii. Click on any  User Testing project 

iv. Click on the Set Up Autoflow button in the autoflow ribbon under the user testing tab at the top 

of the screen 

v. In the left panel of the data capture configuration dialog, click the new button. This will open up 

an untitled screen on the right panel 

vi. Enter the basic information, enter the configuration name 

vii. Enter the description of the product 

viii.  Set this configuration as the default autoflow configuration by checking the default checkbox 

z 

 

 

b)  Autoflow Configuration- Part 2 
ix. Click the add button on the data capture configuration, to add a new action for this 

configuration  

x. Enter the action name, e.g.,  “Informed consent” 

xi. Select Display PDf file from the drop down menu under the “Action Type” column  

xii. Click the button with three dots under the Content column, a dialog will pop up for you to 

choose the PDF file you want to display 

a)-i Go to User Testing tab 
 

a)-ii Double click on your 

desired product to open a list 

of the projects 

 
 

a)-iv Click on the Set Up Autoflow 
button 
 

a)-iii Click on any User Testing 

project 

a)-v Click on the New button 
 

a)-vi Enter the configuration 
name 
 

a)-vii  Enter description 
 

a)-viii Set this configuration 
as the default autoflow 
configuration  
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xiii. Double click on the PDF file then you can see the name of the PDF file under the Content 

column 

To add more actions, follow the same steps. 

xiv.  Click on the Save button 

Please note that clicking the Reset button will revert the form to its original state. 

 

9.2.2 Run Autoflow 

Once the default configuration has been set, a user can start the Autoflow process. The steps will vary 

depending on your configuration, but the basics will be covered here. For navigation, a user can click on the 

Next, Skip, or End Session buttons. The next button will bring a user to the next step. The skip button will skip 

the following step and move the user to the step after. The end session button will close and save all filled 

information up to that point. During a screen recording session, a user or moderator can use the following 

keyboard shortcuts: F8 to pause the recording or F9 to stop the recording. Buttons are also available for these 

shortcuts at the top of the screen. Once a user has reached the last step, click the End Session button to finish. 

b)-ix  Click the add button 
 

b)-x Enter the action name 
 

b)-xi  Select the action you  
would like to add, e.g., 
“Display PDF File” 
 

b)-xiii  Choose the PDF you 
would like to use 
 

b)-xiv  Click on the Save 
button 
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10. User Testing Analysis  
Analyzing Windows Events files gives you more insight into the captured data. Clicking on Windows Events files 

opens up a wide screen with multiple tabs. The functions included in each tab assist you in obtaining more 

information regarding the captured data. The number of tabs in the latest version of Turf is 7. In the following, 

we will discuss each tab in more details. 

a) Computed Events 

This tab allows for evaluating task paths. Here, you can choose whether or not the taken path is correct using 

the radio buttons listed on the right top corner of the screen. Also, you will be able to choose whether the taken 

path has minor or major deviations. In addition, you will get more information about the Mouse and Keyboard 

events associated with each captured module using the drop down box at the top of the page. 

The next button will take a 
user to the next step  
 

The skip button will skip 

the following step and 

move the user to the step 

after  

The end session button will 

close and save all filled 

information  
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b) Original Events 

On this tab, you will get more information about the mouse and keyboard events associated with each module. 

For example, you can see the time and data that each event was recorded. 

 

c) Events Timeline 

The duration of each recorded mouse and keyboard event in milliseconds is displayed here. Turf indicates 

mouse events with green dots while keyboard event are represented by blue dots. As an example, very long 

mouse actions might show that user is not familiar with the system or the order of the widgets on the recorded 

screen is not appropriate. The red dots show that the user had no action during the specified time.  
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d) Keystroke Analysis 

The number of typed letters and words, as well as, the number of times a user had to use the delete and 

backspace buttons will be displayed here. 

 

e) Mouse Trajectory Analysis 

Using this tab, you will be able to assess the effect of training and/or investigate any distracting widget which 

will lead to deviated path. 

 

f) Mouse Click Analysis 
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g) Heat Map 

This tab assists moderators to identify users’ concentration points. The coordination of users’ mouse events 

along with their frequency are used to generate the heat map.  
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11. OneDrive-Upload/Download your 

projects using OneDrive 

 
11.1 Upload to OneDrive 

 
a) Follow the following steps to upload your projects to OneDrive 

i. Go to the File Tab. 

ii. Click OneDrive button on the left navigation bar 

iii. Click on the login button at the bottom right of the screen 

iv. Enter your username and password to log in to your OneDrive account. If you do not have an account, 

you will need to create one 

v. An alert window will pop up warning that Turf will access your account info- Click on the Yes button to 

proceed to the next step 

vi. Go to Setting Tab 

vii. Click OneDrive Settings button 

viii. Change the value of the first field, “Automatically upload files to OneDrive” to True,  if it is set to False. 

Setting the value to True allows you to synch your local files with the uploaded files. This means that 

every changes that you make to your local files will be automatically applied to their counterparts in 

OneDrive.  

ix. Go to the Projects panel tab- (Click on the Home tab) 

x. Right click on your desired folder. Go to “OneDrive” menu item, next, click on “Include in Sync” 

xi. If the value for ”Automatically upload files to OneDrive” field is not set to True, you must click “Sync 

Now” from the context menu. 

xii. An icon on the right lower corner of the screen will appear indicating that the data are being uploaded 

xiii. Upon uploading  a project / folder, you will notice that TurfData4.0 folder is also created in  

OneDrive.This folder will  include data from Turf.  The organization of sub-folders is as follows:  Product 

>> Project >> Folders >> Files.  

 

 



Turf Reference Manual    

 
  

71 

 

 

a)-i  Go to the file tab  

a)-ii  Click on the 
Share File button  

a)-iii Click on the  
Login button  

a)-iv Enter your 
username and 
password  
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a)- v  Click on the 
Yes button  

a)- vi  Go to Setting 
tab  

a)- vii  Click 
OneDrive Settings 

a)- viii  Set this 
value to True  
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b) If you do not want to synchronize your local data files with OneDrive: 

i. Right click on your desired folder.  

ii. Go to “OneDrive” menu item, click on “Exclude from Sync”.  

a)- x  
Right click  on your desired folder. Go to 

OneDrive menu item, click on “Include in 

Synch”, and then Sync Now 

a)- xi  An icon will appear indicating that the file is 

being uploaded 
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iii. “Exclude from Sync” will simply stop syncing the files with their counterparts in OneDrive 

iv. This will not remove the already uploaded data in OneDrive. 

v. You can manually delete the Product / Project / File from OneDrive from any OneDrive app 

11.2 Sharing Turf data on OneDrive with other team members 
Do you want to import the Turf files that your team members have worked on into your Turf application? It is 

simple, as long as they have shared these data with you on OneDrive.  

a) Sharing your Turf data with others: 

To share data with others, you need to access to your OneDrive folder: 

i. Use your browser or any OneDrive applications to go to your OneDrive account where you will be able to  

share your files with others 

ii. Locate the folder “TurfData4.0”. 

iii. Select the folder and edit its share options.  

iv. Share the folder with Edit previleges.  

v. The shared user will get an email notification. 

Accepting shared data from others 

If someone has shared their Turf data with you, you will receive an email notification about the share. Follow the 

instructions in the email to accept the share. You need not add the shared folder to your OneDrive. Simply 

accepting the share will be naough. You should be able to access the folder under Shared Files section in 

OneDrive. 
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a)- ii  Locate the folder “TurfData4.0” 
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11.3 Importing Turf data from OneDrive 
Are your User Testing or Heuristic Evaluation files damaged? Or do you want to download the folders that your 

teammates have shared with you on OneDrive into Turf?  

In general, the file (s) /folder (s) that are uploaded to OneDrive can be imported into a Turf project, or product. 

They come from two different sources: (1) The ones that you have already uploaded to OneDrive, or (2) the ones 

that your colleagues have shared with you on OneDrive. 

To import a project from OneDrive to a Turf product: 

Right click on a product >> Go to OneDrive >> Select import a project from the OneDrive menu item.  

Similarly, to import a folder to a Turf project: 

Right click on a project >>  Go to OneDrive >> Select import a folder from the OneDrive menu item.  

The files/folders that you have uploaded to OneDrive will be displayed in “My Files” tab, whereas, the files that 

your teammates have shared with you will be displayed on “Shared Files” tab.  

When importing a Project or Folder to  “My Files” tab, you will only see the folders and files that are synced with 

that particular project and folder. This means that you will not be able to import folders or files from a different 

project or product using OneDrive function. However, if you use “Shared Files” tab, you will be able to import 

any projects / folders / files to  your local projects or folders .  

The following steps demonstrate how you can import your uploaded data files to a project folder: 

i. Go to the Projects panel. Right click on the project that you want to import the files into. 

ii. From the OneDrive menu item, choose “Import a folder”. This will pop up a new window. 

iii. The new window contains two tabs, “My Files”, and “Shared File”. Go to “My Files” tab and select the 

files that you want to import 

a)- iv  Share the folder with edit previleges 
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iv. Click OK button 

 
 

 

 

 

  

i)- Go to the Projects panel. Right click on the 

project that you want to import the files into 

 

ii)- From the OneDrive option choose “Import a 

folder”. This will pop up a new window 

iii)- Go to “My Files” tab and select the files that 

you want to import 

i. Click Ok button 
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12. Analytic Procedures 
12.1 How to Process Raw Data 

Most of the statistical techniques can be used only with numeric data. During data collection, numeric data may 

be stored as other data types, such as a string. The Convert to Numeric Variable function can be used to convert 

the data from other types to numerical type. 

a) Query Files: 
i. Go to Analyze tab 

ii. Click Query Files 
iii. Select a product, e.g. Demo EHR -> Select a project, e.g. Heuristic Evaluation 1 -> Select a folder, 

e.g.: Electronic prescribing ->  
iv. Select the images where usability problems have been identified in previous steps 
v. Click OK 

 

 
 
 

b) Select the numeric data. To select multiple rows, hold down Ctrl button while clicking on each row 

c) Click the Convert to Numeric Variable button 

a)-iii Select the project 
iv. Select the images 

a)-v Click “OK” 

a)-ii Query Files: Click “Query 
Files” 

a)-i Go to analyze tab 
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12.2 How to Do Descriptive Analysis 
The descriptive analysis within Turf include calculating the sum, mean, variance, standard deviation, range, 
minimum and maximum data, kurtosis and skewness. You choose the analytic method(s) that you want to apply, 
and then generate analysis results. These descriptive analysis results may help to assess the overall usability 
level of a product and identify the major usability problems. The Descriptive Analysis can be done with data 
collected from Heuristics Evaluation as well as User Testing. 
 
Calculate the mean, range, minimum and maximum of severity scores:  
For the severity scores assigned to problems, we are interested in the mean of severity scores, also the range, 
minimum and maximum scores. The following instructions are based on the data collected from Heuristic 
evaluation. However, it can also be done on the data collected from User Testing. 

a) Query Files: 
i. Go to Analyze tab 

ii. Click Query Files 
iii. Select a product, e.g. Demo EHR -> Select a project, e.g. Heuristic Evaluation 1 -> Select a folder, 

e.g.: Electronic prescribing ->  
iv. Select the images where usability problems have been identified in previous steps 
v. Click OK  

 
 
 

b) Select the data 

 

c) Click the “Convert to Numeric 
Variable” button. 
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b) Drag the Image Name to the lower panel. By doing this, the Image Name will be added to the existing 

columns and the name of images falls under this heading.  
c) Select the column of Average Score 
d) Check the checkboxes of Minimum and Maximum 
e) Click the Run button 

 
 

  

a)-iii Select the project 
iv. Select the images 

a)-v. Click “OK” 

a)-ii Query Files: Click “Query 
Files” 

a)-i Go to analyze tab 
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Here, Turf   displays the descriptive analysis results based on your selections.       

 

12.3 How to Compare Means 

12.3.1 Two-Sample T test 

Two-Sample T test helps to determine whether the means of two different data sets differ. For example, a group 

of physicians was asked to do E-prescribing using EHR1, another group of physicians was asked to do the same 

task using EHR2. Now, we are interested in comparing the mean task time for E-prescribing based on the data 

collected from both groups. Note: The Two-Sample T test only focuses on two different sets of data, and 

requires that the distribution of data be normal. If you need to compare means among multiple data sets, other 

hypothesis tests, such as One-way ANOVA should be used.  

b) Query task time 
i. Go to Analyze tab 

ii. Click Query Files button 
iii. Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  
iv. Select windows event files, e.g.: Win_1 to Win_10. 
v. Select Task time 

vi. Click OK  
 
 
 
 
 
 
 

b) Drag “Image Name” to the 
lower panel 

c) Select the column of “Average Score” 

d) Check the checkboxes of “Minimum” and 
“Maximum”. 

e) Click “Run” 
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c) Add categorical columns  
i) Right click on Task time and click Insert Column. The “column data table” window pops up, where 

you can set values for the following properties: “Column Name, Data Type, Selected Column Left, 
and Selected Column Right. 

ii) Enter Column Name, e.g.: Product Name. The data type is preselected on “String”. String indicates 
the data type of the value entered in Column Name. String data type represents text rather than 
numbers. Also, it consists a set of characters that can contain spaces and numbers. 

iii) Choose where you want the column to be inserted, before or after the current column. 
iv)  Click OK 
v) Enter EHR 1 for the first five rows of Product Name Column to indicate it’s Product 1, enter EHR 2 for 

the last five rows of Product Name Column to indicate it’s Product 2 

a)-ii Click “Query Files” 

a)-iii Select Product, 
project, and folder 

a)-v Select Task time 
a)-vi Click OK  

a)-iv Select window events files 

a)-i Go to analyze tab 
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b)-i Right click on Task time 

column header and click 

Insert Column 

b)-ii Enter Column Name 

b)-iv Click OK 

b)-iii Choose where you want the column to be inserted 
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c) Calculate 
i) Select Product Name and Task time Column (select Product Name/Task time, hold down Shift /Ctrl 

button and select another column) 
ii) Click Two-Sample T button 
iii) Add Product Name as Group Variable  
iv) Choose EHR 1 for Group 1, choose EHR 2 for Group 2 
v) Add Task time to the Test Variable(s) list. By doing this step, you indicate that Task time is the 

criteria on which different products are to be compared with each other. 
vi) If two different groups of users involved in User Testing evaluation, you need to choose 

“Unpaired”, otherwise “Paired” should be selected 
vii) Select None  
viii) Click OK 

b)-v Enter EHR 1 for the first five 

rows of Product Name Column 

Enter EHR 2 for the second five 

rows of Product Name 
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12.3.2 Mann-Whitney U test  

Sometimes data is not normally distributed or the samples sizes are so small that one cannot tell whether 
they are part of a normal distribution or not. In these cases you need to use the non-parametric Mann-
Whitney U test. 
 
a) Query task time 

i) Go to Analyze tab 
ii) Click Query Files button. 
iii) Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  

c)-iii Add Product Name as Group 

Variable 

c)- iv Choose EHR 1 for Group 1, 

choose EHR 2 for Group 2 

c)- v Add Task time to the Test 

Variable(s) list 

c) -vi Select Unpaired and None 

c)-vii Click OK 

Results of Two –Sample t 

c)-i Select Product Name and 

Task time Column 

c)-ii Click Two-Sample T 
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iv) Select windows event files, e.g.: Win_1 to Win_10. 
v) Select Task time 
vi) Click OK 
 

 

 
 

b) Add categorical columns 
i) Right click on Task time and click Insert Column  
ii) Enter Column Name, e.g.: Product Name. The data type is preselected on “String”. String indicates 

the data type of the value entered in Column Name. The String data type includes alphabetic 
characters rather than numbers. Also, it allows characters that can contain spaces and numbers. 

iii) Choose where you want the column to be inserted, before or after the current column 
iv) Click OK 
v) Enter EHR 1 for the first five rows of Product Name Column to indicate it’s Product 1, enter EHR 2 for 

the last five rows of Product Name Column to indicate it’s Product 2 
 

a)-ii Click “Query Files” 

a)-iii Select product, 
project, and folder 

a)-v Select Task time a)-vi Click OK  

a)-iv Select window events files 

a)-i Go to Analyze tab 
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b)-ii Enter Column Name 

b)-iv Click OK 

b)-iii Choose where you want the column to be inserted 

b)-i Right click on Task time 

column header and click 

Insert Column 
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c) Calculate 
i) Select Product Name and Task time Column 
ii) Click Mann-Whitney U button 
iii) Add Product Name as Group Variable 
iv) Choose EHR 1 for Group 1, choose EHR 2 for Group 2 
v) Add Task time to the Test Variable(s) list 
vi) Click OK 

 

b)-v Enter EHR 1 for the first five 

rows of Product Name Column 

Enter EHR 2 for the second five 

rows of Product Name 
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12.3.3 One-way ANOVA test 

The one-way ANOVA test is used to compare more than two groups of data. This test shows whether there 
are any significant differences between the means of three or more groups. For example, a group physicians 
were asked to do E-prescribing using EHR1, another group of physicians was asked to do the same task using 
EHR2, and finally the third group was asked to do the same task using EHR3. Now, we are interested to 
compare the means of task time for E-prescribing based on the data collected from each EHR. 
 
a) Query task time 

i) Go to Analyze tab 
ii) Click Query Files button. 
iii) Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  

c)-iii Add Product Name as Group 

Variable 

c)-iv Choose EHR 1 for Group 1, 

choose EHR 2 for Group 2 

c)-v Add Task time to the Test 

Variable(s) list 

c)-vi Click OK 

c)-i Select product name and  

task time column c)-ii Click Mann-Whitney U 

Results of Mann-Whitney U 
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iv) Select windows event files, e.g.: Win_1 to Win_10. 
v) Select Task time 
vi) Click OK 
 

 

 
 

b) Add categorical columns 
i) Right click on Task time and click Insert Column 
ii) Enter Column Name, e.g.: Product Name. The data type is preselected on “String”. String indicates 

the data type of the value entered in Column Name. The String data type includes alphabetic 
characters rather than numbers. Also, it allows spaces and numbers. 

iii) Choose where you want the column to be inserted, before or after the current column. 
iv) Choose where you want the column to be inserted, before or after the current column 
v) Click OK 
vi) Enter EHR 1 for the first three rows of Product Name Column to indicate it’s Product 1, enter EHR 2 

from the fourth to sixth rows of Product Name Column to indicate it’s Product 2, enter EHR 3 for the 
last four rows of Product Name Column to indicate it’s Product 3 

a)-ii Click “Query Files” 

a)-iii Select Product, 
project, and folder 

a)-v Select Task time 

a)-vi Click OK  

a)-iv Select window events files 

a)-i Go to analyze tab 
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b)-ii Enter Column Name 

b)-iv Click OK 

b)-iii Choose where you want the column to be inserted 

b)-i Right click on Task time 

column header and click 

Insert Column 
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c) Choose variables 
i) Select Product Name and Task time Column 
ii) Click One-way ANOVA button 
iii) Add Product Name as Factor. This step specifies different groups of the test which based on our 

scenario, are EHR1, EHR2, EHR3.  
iv) Add Task time to the Dependent list. According to our scenario, it means that three different 

groups are compared with each other based on the task time criteria. 
v) Click OK 
 
 
 
 
 
 
 
 
 
 
 
 
 

b)-v Enter EHR 1 for the first five 

rows of Product Name Column 

Enter EHR 2 from the fourth to 

sixth rows of Product Name 

EHR 3 for the last four rows of 

Product Name Column 
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c)-i Select product name and  

task time column 

c) – ii Click One-way ANOVA 

c)-iii Add Product Name as factor 

-iv Add Task time to the Dependent 

list 

c)-v Click OK 

button 

Results of One-way ANOVA 



Turf Reference Manual    

 
  

94 

12.4 How to Calculate  

12.4.1 Count  

In addition to the analytical tests described earlier, you can count the frequencies of each documented design 
violation by using Count Function in Turf. The count function helps evaluators understand which are the most 
violations in one project. 
a) Query Files: 

i. Go to Analyze tab 
ii. Click Query Files 

iii. Select a product, e.g. Demo EHR -> Select a project, e.g. Heuristic Evaluation 1 -> Select a folder, 
e.g.: Electronic prescribing ->  

iv. Select the problems, e.g.: select Prob_1, Prob_2. 
v. Click OK 

 
 

 
 
 
b) Count: 

i. Select the column Design Violation (make sure the selected problems have documented Design 
Violation) 

ii. Click the Count button 
iii. Drag the Variable Name to the lower panel. The result of this step shows based on what criteria 

the count function was triggered. Performing this step is a simple way to organizing the data 
displayed on the screen. 

a)-iii Select the project 
iv. Select problem1, and 2 

a)-v Click “OK” 

a)-ii Query Files: Click “Query 
Files” 

a)-i Go to analyze tab 
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You will get the frequencies of each error type and design violation, as appropriate. 
  

  
 
  

b)-i Select the “Design Violation” 
column 

b)-ii Click the “Count” 
button 

b)-iii Drag the Variable 
Name to the lower panel 
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12.4.2 SUS Score 

The System Usability Survey (SUS) can be used to quickly test the usability of a product. After collecting the 
surveys with 10 items from all participants (for more information, please refer to the section 4 of the current 
document), you can convert the raw scores of each survey into an overall SUS score which ranges from 1 to 100. 
Then you can use the descriptive analytics in Turf   to calculate the average SUS score.  
a) Query SUS 

i) Go to Analyze tab 
ii) Click Query Files button 
iii)  Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  
iv) Select SUS files, e.g. SUS_1, SUS_2, and SUS_3. 
v) Click OK 

 

 
 

b) Calculate overall SUS score 
i) Select all the rows (Click on the small arrow next to any of the rows, hold down Ctrl/Shift button, 

and select other rows). 
ii) Click SUS Score button 

 
 
 
 
 

a)-iii Select Product, 
project, and folder 

a)-iv Select SUS files 

a)-ii Click “Query Files” 

a)-v Click OK 

a)-i Go to Analyze tab 
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c) Calculate average SUS score 
i) Select SUS Score column 
ii) Select Mean by checking the checkbox of mean 
iii) Click Run button 

  

 
 
 

 
 

12.5 How to Do Regression 
In statistics, regression analysis is a statistical process for estimating the relationships among variables. It 

includes many techniques for analyzing variables. Here we discuss the most commonly used techniques: “Linear 

Regression”, and “Pearson Correlation Coefficient”. 

12.5.1  Linear Regression 

A linear regression is a statistical model that attempts to show the relationship between two variables with a 

linear equation. It simply describes how a variable varies based on the change of the other variable. For 

example, you might be interested to know how the task time of E-prescribing would change based on the 

decrease or increase in the number of steps taken for E-prescribing. 

a) Query task time 
i) Go to Analyze tab 

c) –i Select SUS score 

c)-ii  Select mean 

-iii  Click Run 

b)–i Select SUS scores 

Average SUS score 

b)-ii Click SUS Score button 
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ii) Click Query Files button 
iii) Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  
iv) Select windows event files, e.g.: Win_1 to Win_10. 
v) Choose your desired variables to see the relationship between them. Here, we select Task time, and 

Number of steps.  
vi) Click OK 
 

 
 
b) Choose variables 

i) Select Number of steps and Task time Columns (click on any of these columns, hold down Ctrl/Shift 
button, click on another column) 

ii) Click Linear Regression button 
iii) Add  Number of Steps as Independent 
iv) Add Task time to the Dependent  
v) Click OK 

 

a)-ii Click “Query Files” 

a)-iii Select Product, 
project, and folder 

a)-v Select Task time & number of steps a)-vi Click OK  

a)-iv Select window events files 

a)-i Go to analyze tab 
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12.6 How to Do Correlation 

12.6.1 Pearson Correlation Coefficient 

Correlation is a technique for investigating the relationship between two quantitative variables. Pearson's 

correlation coefficient is a measure of the strength of the association between the two variables. It describes 

how two variables vary together. For example, you might be interested to know whether there is any relation 

between the number of errors and the number of steps taken for E-prescribing. 

a) Query task time 

b)-iii  Add Number of steps  as 

independent 

-iv  Add Task time to the Dependent 

b)-ii  Click Linear Regression button 

 

The result of Linear 

Regression 

b)-i Select Number of Steps and Task 

Time columns 

 

b)-v Click OK 
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i) Go to Analyze tab 
ii) Click Query Files button 
iii) Select a product, e.g. Demo EHR -> Select a project, e.g. User Testing 1 -> Select a folder, e.g.: 

Electronic prescribing ->  
iv) Select windows event files, e.g.: Win_1 to Win_10. 
v) Select Task time & Number of steps 
vi) Click OK 
 
 

 
 

b) Choose variables 
i) Select Number of steps and Number of errors Columns (click on any of these columns, hold down 

Ctrl/Shift button, click on another column) 
ii) Click Pearson Correlation Coefficient button 
iii) Add Number of steps and Number of errors to the Dependent list 
iv) Click OK 

 
 
 
 
 
 
 
 
 
 
 
 
 

a)-ii Click “Query Files” 

a)-iii Select Product, 
project, and folder 

a)-v Select Task time & number of steps a)-vi Click OK  

a)-iv Select window events files 

a)-i Go to analyze tab 
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13. Pivot table 
Pivot tables summarize data in an intuitive and quick way. After you have selected the parameters that you want 

to analyze, click on “Switch to Pivot table/Chart” at the bottom of the screen.  

 

b)-iv Click OK 

b)-iii Add Number of steps and 

Number of errors to the 

Dependent list 

 

b)-ii Click Pearson Correlation 

Coefficient button 

 

The result of Pearson 

Correlation Coefficient 

b)-i Select Number of steps and 

Number of errors Columns 
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The following screen appears: 

 

If you prefer, you can adjust the columns’ widths, so you can see the descriptions. On this screen you will see the 

aggregated results for each of the field names that you have selected.  

Clicking on “Data Headers” will show you the field names. You can drag the field names into the column, or row 

to design the layout of your pivot table and back to the Data Headers to remove it. You will do this process until 

you get the desired report. Drag and drop field names on “Drop Row Fields Here” help you summarize results 

based on that particular field. You can also drop your field names to the “Drop Filter Fields Here” if you do not 

want to include them in your report. 
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If you click on “Save Template”, you will be able to save the layout of your pivot table as a template and then 

apply it to other data files. 

 

 

14. Common Industry Format (CIF) 
The Common Industry Format (CIF) is a standard format for reporting the results of summative usability testing. 

In the following we will show how to export the results of Demo files, Win event files, Performance files, and 

SUS files into the Turf Storyboard (the number of components to be included in the CIF reports varies based on 

your goal), and how to use the  accumulated results in the Storyboard in the CIF template. Before following the 

steps listed below, make sure you already have created the required files.  

a) The following steps demonstrate how to use the CIF template 

 
i. Go to Home, or User testing, or Heuristic Evaluation tab 

ii. Under the Projects panel, select a Heuristic Evaluation or User Testing project 

iii. Select one of the use cases 

iv. Under the details panel on the bottom of the right panel, select the TURF_CIF_Template. Fill in the 

document, as needed. 

v. Press the “Export Files” button 

vi. Select where you want to save this template 
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To gather the results of the files that will be included in the CIF template follow the following steps: 

First, we will select the results of the Win files. But before proceeding, make sure you have already defined the 

number of errors in each windows event file.  

b) Follow the following steps to define the potential errors of the windows event files 

 

i. Go to Home, or User testing, or Heuristic Evaluation tab 

ii. Select the appropriate folder where you have saved your windows files  

iii. Under the Details panel, click on the Win files that you want their results to be included in the CIF 

report 

iv. Once they are opened on the top panel, go to the Error Coding column. For each documented 

mouse event, define the type of error if applicable. 

v. Press the Save button 

 

c) Select the results of the Win files for using in the CIF report 

 

i. Go to Analyze tab 

ii. Press the Query Files button 

iii. Select your desired Product, and then Project 

iv. Select the windows event files that you want to include in the report 

v. Select “Number of steps” and “Number of errors” 

vi. Press the OK button 

vii. Select the entire table by dragging the mouse over it 

viii. Click on “Export to Storyboard” button 

 

d) Select the results of the Performance files: 

 

i. Go to Analyze tab 

ii. Press the Query Files button 

iii. Select your desired Product, and then Project 

iv. Select the PFM files that you want to include in the report 

a)-iii   Select one 

of the use cases 

a)-iv Select  

TURF_CIF_Temp

late 

a)-v Press the 

“Export Files” 

button 
a)-vi Select 

where you want 

to save this 

template 
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v. Press the OK button 

vi. Select the entire table by dragging the mouse over it 

vii. Click on “Export to Storyboard” button 

 

e) Select the results of the SUS files: 

 

i. Go to Analyze tab 

ii. Press the Query Files button 

iii. Select your desired Product, and then Project 

iv. Select the SUS files that you want to include in the report 

v. Press the OK button 

vi. Select the entire table by dragging the mouse over it 

vii. Click on the SUS Score button (this calculates the individual SUS score for each participant) 

viii. Select the SUS Score column  

ix. On the “Descriptive Analysis” ribbon, select Mean, Max, and standard deviation 

x. Click on the Run button (now you have SUS Score for all of the individuals that have completed your 

survey) 

xi. Select the entire table by dragging the mouse over it 

xii. Click on “Export to Storyboard” button 

 

f) Exporting the file from the Storyboard 

Now that you have the results of all components copied to the Storyboard, 

i. Go to the Storyboard 

ii. Click on the Export Document button 

iii. Select the RTF file as the export format 

iv. Press the OK button 

v. Select the location where you want to save it 

vi. Press Save button 

 

g) Importing the exported data to the CIF template 

 

i. Open the file containing the data copied to the Storyboard 

ii. Select all data by pressing Ctrl+A keys 

iii. Use Ctrl+C keys to copy data 

iv. Open the CIF template  

v. Scroll to the bottom of the document where the Appendix is 

vi. Under this heading, paste your data 

vii. Save your file 
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15. Settings Procedures 
15.1 How to Do System Configuration 

15.1.1 Use Cases 

The Use Cases button opens a mini tab that allows the user to create, modify or upload a new use case. New 

Use Case opens a window popup where users can enter the name and the description for a new use case they 

create. New Folder opens a window popup where users can name a folder and description to keep new, old and 

updated cases organized. Modify allows users to rename a folder/ use case. Delete permanently deletes the 

selected folder/use case. Clicking Load allows the user to find an XML file from the computer to upload to Turf. 

Clicking on Upload opens a popup window where users can upload a PDF/RTF file by selecting the path and 

creating a brief description. Clicking Export allows the user to save a use case file in XML format to a folder 

chosen by the user. 

15.1.2 Descriptive Template 

The Descriptive Template button opens a mini tab that allows the user to create, modify or upload a new 

template. These templates can be used as Evaluation Templates for a Heuristic Evaluation Project. New opens a 

new template mini tab where the user can create a template from scratch, selecting the name, dimensions, 

description, etc. Load opens a window where the user can upload an XML format of a new template from the 

computer. Export allows the user to save the template in XML format to a folder chosen by the user. Delete 

permanently removes the template selected. Clicking on any of the 5 default templates opens the template in 

another mini tab to allow template editing.  

15.1.3 Widget Definitions 

Widget Definitions opens a mini tab where users can assign different icons, such as, Button, TextBox, List 

Box, Check Box or ComboBox to problems found in the images captured from different resources, such as, a 

HTML page, an Android device, an IOS device, or a windows screenshots.  

15.1.4 Color Definitions 

Color Definitions opens a mini tab that allows the user to set the unique color for Windows events color and 

Mark property color from a dropdown list of a Color Category. Users can Add Field or edit an existing field by 

customizing the Name, Color used, Description of the field and Active checkbox.  

15.1.5 Hot Key 

Hot keys can be customized for each of the 6 tabs. Hot keys can easily be modified by clicking on the 

ActionName of the hotkey, then clicking on  the Modify Hotkey Value, and choosing a unique hotkey value in a 

Set Hotkey popup. The user can customize the Hotkey keystrokes if the hot keys are Active.  

 

 

 



Turf Reference Manual    

 
  

107 

15.1.6 Video Settings 

The Video settings allow users to specify the maximum number of video tabs that can be opened at the same 

time. 

15.1.7 OneDrive Settings 

OneDrive settings allow you to customize the way that you want Turf interact with your OneDrive account. 

15.1.8 Install Turf for Android Settings 

Install Turf for Android settings allow you to install Turf on your android smartphone or tablet device. 

 

16. Troubleshooting 
16.1 Recover Interrupted Files  

 

A one-of-a-kind characteristic that Turf has is its ability to restore interrupted media files. If there is any 

interruption in recording media files, launching turf will open a pop up window prompting you to save the 

corrupted file. Clicking on the OK button will restore the corrupted files and you will not lose any data. 
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17. Recommendations 
17.1 Labeling Files 

 

Turf assigns a label to each file based on the system default settings. It is recommended to rename the files 

in a way that makes sense for you. For example, if you have different notes in a folder, it is recommended to 

organize them in a systematic way. Labeling each note with its corresponding media file might be a good 

idea. 

18. Update Instructions 
Please follow the instructions below to update the earlier versions of Turf to the latest one (4.0): 

i. Uninstall the current version: control panel >>  programs >> uninstall a program >> select Turf >> 

uninstall 

ii. If you have data from Turf old versions (Truf 3.0.1 and higher) and you want to access them in new 

version: 

a. Make a backup of current TurfData located in C:\Users\<user name>\Documents\TurfData3.0 

b. Rename the folder from TurfData3.0 to TurfData4.0 

c. The files can be accessed in Turf4.0, however, the Heat Map function will not work on the 

keystroke events recorded in earlier versions. 

iii. Install the new version: For the instructions on how to install Turf, please click here.  

iv. Launch new version – Turf 4.0 

v. Your activation key used for Turf 3.0.1 will not work and will need new activation licence. 

 


